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Welcome to Help
Welcome to Help.    You are encouraged to use the electronic Help files when using the software.    The 
Help file is sized to fit the right hand side of your screen while leaving the left hand side of the screen 
available for active use in the software.    In this way you can have both the software and the Help files 
visible at the same time (see Help).

Refer to the Installation Guide for:

Hardware and Software Requirements

Package Contents

Installation of the Software

Product Support



Working With Help
To quickly switch between the Help file and Software screens, hold the Alt key and press the Tab key. 

To work with the software and keep the Help file visible, open the Help file and select Always On Top 
from the Help file's Help menu.    The Help file remains visible (on top) as you work with the software.    

If you click the Minimize button , the Help Icon remains on the screen.    Double click the Icon to 
reopen the Help file.

To return to a previous screen, press B or click the Back button.

For more on working with Help files, open How to Use Help from the Help menu.



Where to Start
Begin by selecting products with one of the search paths from Welcome screen.    As you identify products
of interest, save them in a project file for easy access.

Search Paths

Depending on your need, you can access one of four categories to start a search path and arrive at the 
Product Summary Screen.    Once you acquire the product information, you can manipulate, evaluate, 
compare, discard, or retain the data you need.    (see Using Search Catagories and Product Data 
Windows).

Project Files

Project files allow you to retain information about your product choices (found through the Search 
process).    You can open an existing file or start a new one at any time no matter where you are in the 
software (see Project Files).



Diagram of Search Paths
Select a Search method

1. All Products
2. Sweet's Data Filing Format (CSI)
3. Trade Name
4. Sweet's Product Area Index

Build a search using the Category Structure

(Sweet's Data Filing Format (CSI))
                  Division 8 - DOORS AND WINDOWS
                              08600 - Wood & Plastic Windows
                                          08630 - vinyl windows

Further define the product using
Properties and/or Options

Use one of the available Property Buttons 
(Physical/ Functional, Material/Finish, Installation/
Maintenance, or Applications/Environment), 
and/or
an Options Dialog Box to further qualify the 
product.

Elect to view the results of your search
by accessing the Product Summary Screen

Choose from a list of manufacturer's products.

View a Snapshot or View a Showcase
Definitive product data 
(text, image, table and/or 

Company overview or 
general product line 



CAD). information.

Diagram of Project Files 
Start a New file or Open an existing one

Use File / New to start a new Project File

Select products from the
Product Summary Screen

Only Manufacturer Data Windows are displayed 
in Project Files.    Both Snapshot and Showcase 
elements are found in the User Showcases.

Project File
Drag and drop product Data Windows into the 
Project file.

 

Track project data

Track Project File Information 
(project name, number, client name, etc.) 
and Product Summary Information 
(tasks to do, status of product choice, etc.).



Using the Search Methods
There are three ways to access the search methods which ultimately take you to a Product Summary 
Screen. From the Product Summary Screen you can access two ways of looking at manufacturers' data: 
Snapshots and Showcases.

Click one of the buttons on the front Welcome Screen to start a search.

Or, click Search from the pull-down menu as shown below. The available search methods are fully 
explained later in the Product Selection Methods section.

Or, use the one of the following keyboard commands:

Alt + M = All Products

Alt + C = Sweet's Data Filing Format (CSI)

Alt + T = Trade Name

Alt + P = Sweet's Product Area Index

Each method brings you to a series of selections which lead to a Product Summary Screen and Product 
Data Windows.



Product Data Windows
The selection methods ultimately bring you to a set of products.    The products display in individual Data 
Windows on the Product Summary Screen.    

Shown below is a Product Data Window. This Data Window provides access to the product information. 

(1) It shows you the company logo and the name of the company. 

(2) The Sweet's printed catalog reference 

(3) The Sweet's BuyLine number 

(4) The product's trade name or product series

(5) The information types contained in the Snapshot

(6) Whether or not a Showcase is available

To work with a product, click its Product Data Windows to focus the product.    Once a Product Data 
Window is selected and is highlighted, you can:

· View the Snapshot or Showcase product information, 

· Add the product information to a Project File, or 

· Print a copy of the Snapshot as a cut sheet by clicking the Print Cutsheet button.    This prints 
everything available in the software on this product (text, CAD drawings, tables, images).

· Sort a list of products using the Sort menu.

· Print product information as a list by selecting Print from the File menu (not the Print Cutsheet 
button).

Related Topics:
Icons and Data Windows
Viewing Products and Showcases
Comparing Products



Icons and Data Windows

There is a series of small graphic images at the bottom of the Data Window which represent the 
electronic information found in the software.

These four graphics represent the elements found in a Snapshot. In order, they are: Text, image (may be 
photographs, illustrations, etc.), CAD Drawings, and tables. Any combination of these items are found in 
Snapshots. Only those items included by the manufacturer in a Snapshot are graphically indicated in the 
Data Window.

The last graphic represents a Showcase. It does not appear unless the manufacturer has included a 
Showcase in the data presentation.



Viewing Products and Showcases

Regardless of how you get to the Product Summary Screen (directly searching on a specific tradename or
searching through one of the hierarchical outlines and using the Show Product Button from the tool bar), 
you are now ready to look at product information. 

To look at the product data, give the Data Window focus (click it). Notice how the graphic images (if 
available) are now displayed in color. When you click the Data Window, the Snapshot and Showcase 
buttons on the Tool Bar also become available based on the material included by the manufacturer.

                      

The data element icons tell you what items are in a Snapshot (text, image, table and/or CAD drawing) and
whether or not a Showcase is available. The Showcase and Snapshot Buttons on the tool bar let you 
select the one you wish to see.



Comparing Products

If you wish to compare data elements (text, image, table or CAD drawing), you can do so from the 
Product Summary Screen using the View menu bar selection. You can only compare like items (such as 
CAD drawings to CAD drawings).

If you have two products with CAD drawings, click on the Data Windows to give them focus, and select 
Drawing. 

The following example shows two CAD drawings being compared. In both instances, the Zoom Window 
function was used to compare a specific portion of both drawings.

As you can see, both portions of the drawing are easily read and compared. They are both large enough 
to understand the detail being shown.



Be conservative in the number of windows you have open at any one time for viewing and comparison. 
Comparisons from product to product are best accomplished with only two items. If you select four or 
more products and then view the text, you'll have four or more small windows on the screen. It is difficult 
to read the information in any of them without maximizing the window or highlighting the text and sending 
it to a printer.

You can compare a maximum of nine items. If you attempt to compare more than nine, the software may 
fail.



Snapshots
To access a Snapshot, from the Product Summary Screen provide focus to the Data Window of your 
choice (click it), and click the Snapshot Button from the tool bar. The Snapshot displays.

A Snapshot can contain up to three of the four electronic information types (text, image, table or CAD 
drawing), each of which is graphically represented on the Data Window if it is available (see Icons). 

Once a Snapshot displays, you have a variety of tools available for manipulation of the data and its 
display on the monitor. Notice the buttons at the top of the Snapshot Screen.

Each window in the Snapshot has a maximize and minimize button (see your Windows documentation). 
You can change any window into an icon using the minimize button, or you can fill the entire product 
display area with a single window by clicking the maximize button. Text, tables and CAD drawings fill the 
entire Snapshot display area when they are maximized. Graphics (including photographs) often have 
white space left over in the product display area. Sometimes it is not possible to proportionately expand 
graphics to fit the available space.



Text
If focus is on text, the tool bar allows you to:

· Copy the information to Windows Clipboard™. It is now available to paste into any Windows 
word processor or text editor. Highlight all or a portion of the text you wish to copy by dragging 
the mouse.

· Print the text to a printer. Highlight all or a portion of the text you wish to copy. In the following 
example, the maximize button was used on the text window so it fills the entire screen. Part of 
the text was highlighted by pressing down the left mouse button, holding that button down, and 
dragging the mouse. 



Image (photographs, illustrations, other)
If focus is on the image window, the buttons on the tool bar allow you to:

· Copy the image to Clipboard. You can paste it into any other Windows application which can 
receive a graphic image (such as a word processor, Windows Paintbrush™, etc.). The image is a
bitmap.

· Print the image to a printer. It is proportionate to the original graphic.

Most Windows graphic programs support the images from the software.



Tables 
Tables provide information in chart or spreadsheet form. They are ideal for viewing similar products that 
have a variety of options, sizes, and features.

Related Topics:
Copying and Printing Data From a Table
Comparing Columns in Tables



Copying and Printing Data From a Table

Numbered buttons identify each table row. Column heading buttons identify each column. To select an 
entire row or column, click the row or column button. Click the button in the upper left corner to select the 
entire table.

To copy the entire table, provide focus to the table and click the Copy button. The Guide copies the 
data and the column headings to Windows Clipboard. Paste the data into another Windows 
application.

If you want only a portion of the table, highlight the rows or columns you wish to copy before clicking 
the Copy button. Select rows or columns by clicking the row number or the column heading buttons. 
This highlights each row or column. To select (and deselect) the entire table, click the button in the 
upper left.

To copy individual cells from the table, click the cells you wish to copy and click the Copy button. 
Again, the selected cells and their column headings are copied to Clipboard.

Paste the data into Excel or a similar spreadsheet application. If you need the data in Word 
Processing, copy to a spreadsheet first and then copy to a word processor. The text in Word 
Processing is then formatted and more easily manipulated.

If you select Print, the table heading, column and row markers, and the selected table data is printed.



Comparing Columns in Tables

To compare columns or data side by side, freeze or lock the first column and scroll the other columns past
it.    

Place the mouse pointer in the column you wish to freeze.    

Click the right mouse button.    The frozen column displays in Aqua.    

Use the scroll bar at the bottom of the screen to scroll the remaining columns past the frozen one.

Copy the information to Clipboard. It is now available to paste into other Windows applications. The 
table name and column headings are included. The ideal program to take table information to is a 
spreadsheet.



CAD Drawings
The CAD Window allows you to zoom in and view drawing details, compare two or more CAD drawings 
side by side, or to transfer the data to another software application. 

· Use the Zoom Buttons to examine the drawing more closely.

· Save the drawing as either a DXF or DWG file. You can then open the file as a separate drawing 
in a CAD system or insert it into an existing drawing.

· Copy the drawing to Windows Clipboard and Paste the drawing directly into AutoCAD for 
Windows.    

· Copy the drawing to Windows Clipboard and Paste the drawing as an image into software 
capable of accepting graphics.    

· Print the drawing directly to your printer. The drawing is proportionate to the original drawing but 
not to scale.    Simply select File and Print.

· Compare two CAD drawings side by side.    Select the Product Data Windows for each product, 
then click the View menu and select the Drawing command. 

· Change the CAD Viewer Background color.    The default background for viewing CAD drawings 
is black. If you prefer either white or gray, you can change your system 

Related Topics:
Using the Zoom Feature
Saving CAD Drawings as DWG or DXF Files
Copy and Paste to AutoCAD for Windows
Copying a CAD Drawing as an Image
Configuring the CAD Viewer



Using the Zoom Feature

To examine drawings closely, the viewer provides three zoom buttons.

· Zoom Window. Click and hold the button. You can box any area of the CAD drawing for a closer 
look. This is a one time select button. If you wish to zoom in again, click the button again.

· Zoom Previous. This returns you to your previous zoom. You can click the button continuously 
to back up through your series of Zoom Window selections.

· Zoom Fit. If you have used Zoom Window several times in the drawing and wish to return to the 
fully displayed drawing, click Zoom Fit.



Saving CAD Drawings as DWG or DXF Files

To save the file for use with your CAD system, save it as a DWG or DXF. From the main menu bar, click 
File and Save As. Select DXF or DWG and assign a path and file name.    



Copy and Paste to AutoCAD for Windows

To copy a CAD drawing directly to AutoCAD for Windows, you must first change the system configuration. 

Click  File  and  Configure  (Alt, F, G)

The Configure System dialog box displays.    In the CAD Viewer area of the Configure System dialog box, 
click the Command check box. This causes the software to add an insert instruction to the Windows 
Clipboard file. 

To learn more about the Insert instruction, click here: Insert Drawing Block Instruction.

To copy the CAD drawing, focus the CAD Window of the product screen and click the Copy button. The 
drawing and the Insert command are copied to Windows Clipboard. 

If you wish to learn how to view the drawing in Windows Clipboard, click here: Viewing the Drawing in 
Clipboard

Next, start AutoCAD for Windows and open a new or existing drawing. There are two methods for 
Inserting the drawing depending on the version of AutoCAD you are using.

When you paste the drawing, both AutoCAD versions ask for an insert point, scale, rotation, etc. Answer 
each question as you would with any AutoCAD Block Insert.

Related Topics:
Pasting in AutoCAD 12 for Windows
Pasting in AutoCAD 13 for Windows



Pasting in AutoCAD 12 for Windows
If you are using AutoCAD 12 for Windows, select the Paste Command from the Edit menu as follows:    

Click  Edit  and  Paste Command  ( Alt, E, P )



Pasting in AutoCAD 13 for Windows
If you are using AutoCAD 13 for Windows, place your cursor in the Command area at the bottom of the 
screen and press the Right Mouse Button to access the Command area shortcut menu.    Select Paste 
to Insert the drawing.    



Insert Drawing Block Instruction
The Clipboard Command text creates an AutoCAD Insert Block instruction. The Clipboard command tells 
AutoCAD to go to the electronic product information files, get the drawing, and insert it as a drawing 
block. The command has three parts:

Insert %s \n

Insert The AutoCAD Insert Block command.

%s The file name and location of the drawing.

\n Insert line command. This executes the Insert.

The %s is replaced by the file name and location of the drawing. If you view the Clipboard, the text 
displays as follows:



Viewing the Drawing in Clipboard
When viewing the drawing in Clipboard you may display Text or Picture. 

Text is the insert command line. 

Picture is the image.



Copying a CAD Drawing as an Image

If you wish to place a CAD drawing into a word processor or graphics program as an image, you can do 
so with the copy command.    First, change the system configuration.

Click  File  and  Configure  (Alt, F, G)

The Configure System dialog box displays.    Set the CAD Viewer configuration to Drawing only.    

Select the CAD drawing you wish to copy and adjust the image size and view.    

· Adjust its size and position using the Zoom buttons and 

· Adjust its border by moving the CAD drawing's Window frame.    

The image size is the same as the CAD drawing's Window size.    When the drawing size and view are 
set, click the Copy button.

Paste the CAD image into a word processor or graphics program.    The CAD image displays as a Raster 
or Vector image, depending upon the software you paste it into.    For example:

· Pasting into Paintbrush results in a Raster image.    An image of this tyype is difficult to resize 
without significantly distorting the image.    

· Pasting the image directly into Microsoft® Word, however, produces in a Vector image.    This 
image retains its resolution when resized.



Configuring the CAD Viewer

Click File from the main menu, Configure from the pull-down menu, and the Configure System Dialog 
Box displays. Make your selection in the CAD Viewer section of the dialog box. 

Background Color: The default color for the CAD Viewer is black. Changing the default background only
effects the screen display, not the image or the exported file. Do not have a CAD drawing open when 
changing the settings. You may create errors.

Note: You must close and reenter the software for this configuration change to take effect.

DXF Precision: This refers to the decimal place precision for X, Y, Z coordinates. Six digits are sufficient 
for most applications.

Note: You must close and reenter the software for this configuration change to take effect.

Copy and Clipboard Command: These options are described in the Copy and Paste to AutoCAD for 
Windows and Copying A CAD Drawing as an Image.



Showcases
Once you reach the Product Summary Screen, the Data Window tells you if a Showcase is available by 
displaying the trophy icon.

To access a Showcase, provide focus to the Data Window of your choice (click it) from the Product 
Summary Screen, and click the Showcase Button from the tool bar. The Showcase displays.

The data here is often general in nature, provides overviews of product groups, or gives some information
about the manufacturer. Also, in most cases each manufacturer Snapshot is also displayed as a "slide" in 
the Showcase.

The Showcase Tool Bar provides control buttons similar to those found on a VCR. 

To view the "slides" in a Showcase sequentially, you must set the timer for a sequenced slide display. Do 
this by moving the scroll button between the left and right arrows until your desired display time is set (as 
shown in text to the right of the scroll bar). 



If you wish to view the showcase continuously, click the Loop box. Once the last slide in the Showcase is 
reached, it automatically restarts the display of the screens again. 

Once everything is set, select the Play button to review all the Showcase slides. The other control buttons
are activated once Play is selected.

You can also click the item you wish to see from the list box below the timer on the tool bar. If all the 
slides available in the Showcase cannot be listed, a scroll bar displays for you to look at the remainder of 
the list.



Project Files
The software gives you the ability to create Project Files to retain information about your product choices. 
You can open an existing file or start a new one at any time no matter where you are in the software.

Related Topics:
Start a New Project
Open an Existing Project
Printing a List of Products
Project File Information Window
Product Summary Window



Start a New Project

When you start a new file, you are not required to immediately provide a file name. When you decide to 
save your file, use the standard Windows filing conventions for file naming. The file extension (.prj) is 
automatically added to your file.



Open an Existing Project

When you open an existing file, the software displays listings of all files with the .prj extension. You must 
remember where you've stored your files so you may now access them. Use the standard Windows filing 
conventions to obtain an existing file.

Project Files are used when you wish to retain cumulative product information for a specific purpose. 
Shown below is the start of a new Project File.

When in the Product Summary Screen, you can drag information from your list of products and place it in 
the project file. Or, you can select one or more Data Windows and use the Add to Project File Button 
available from the tool bar at the top of the screen. 

The selected Data Window is copied to the Project File. You can continue to add items to the Project File 
from this product group or do another search into a different product group for other products.

Once project files contain product data, you have two additional functions available to you. Provide focus 
to the project file to access the Project File Information Button or the Project Summary Button.

Remember: The tools on the tool bar change depending on where you are in the software and what item 



or area in the screen has received focus (is selected).



Printing a List of Products

Print or Copy a list of products for future reference from the Project File or Product Summary Screen. 
Select individual items by clicking them with the mouse or select all items with the Select All button.    

To send the list of products to your printer, 

Select  File  and  Print  (Alt, F, P)

Do not use the Print Cutsheet button to print a list of products.    
Print Cutsheet prints every screen element for every product selected.    

To copy a list of items to Windows Clipboard,

Select  Edit  and  Copy (Alt, E, C)

Paste the list into a Windows compatible spreadsheet such as Microsoft® EXCEL™. 



Project File Information Window

Use the Project File Information Button from the tool bar to access the Project File Information dialog 
box.

The Project File Information dialog box allows you to enter data on the project name and number, the 
client name, contact, address and much more. Additionally, there is an area to add free notes if you need 
to include comments about the project. 

If the default headings provided with the software do not fit your needs, click File from the main menu bar,
Configure from the pull-down menu, and the Configure System dialog box displays. You can change the 
labels for all the fields available for the Project File Information.





Product Summary Window

Use the Product Summary Button from the Tool Bar to access the Product Summary dialog box.

The Product Summary dialog box allows you to make specific notes about every product in the project. 
For each product you can view the manufacturer's logo and name just as it appears in the general 
Product Summary Screen. You can record tasks to do or done for this specific product. You can also 
answer status questions. And, there is an area to add free notes if you need to make some kind of 
commentary about each product.

If the default headings provided with the software do not fit your needs, click File from the main menu bar,
Configure from the pull-down menu, and the Configure System dialog box displays. You can change the 
labels for all the fields available for the Product Summary Information.

Selecting boxes in either the Project File Information dialog box or the Product Summary dialog box does 
not actually perform the task. It simply notifies you or another person that action is either required or 
finished.



Use of the Project File has many benefits whether one or several people are working on a project. 



Product Selection Aides
Search Buttons
Selecting Product Options
Example Search



Search Buttons

During the Search process, a variety of buttons display on the Tool Bar.    Following is a brief description 
of the buttons.
Button Description

No matter where you are in the software, click the 
Start Over Button and the Welcome Screen 
displays.    

As you navigate through the software, it is often 
advantageous to look at the definitions used in the 
Guide.    In this way, everyone is working with the 
same understanding.    To use, select the word for 
which you want to see a definition, and click the 
Show Definition button .
When in the Search function, the Show Product 
button becomes selectable at the point actual 
product is available for viewing.    The availability of 
this button means you have traversed far enough 
through the Category Structure to look at products 
matching your selections.
The Product Detail button is available at the point 
where specific property qualifiers are selectable for 
your choices in the hierarchical outline.    Click the 
Product Detail buttonand an Options Dialog Box 
displays in which you can further define/qualify the 
product on which you are searching.    The default 
property for the software is Physical/ Functional.
The Property Buttons allow you to further define 
your search based on specific qualifiers.    The four 
properties in the software are shown at the left.    
The software uses Physical/Functional as the default
property.    If you wish to qualify the search by some 
other property, click the appropriate button.    
It is important to remember that all products do not 
have all properties.    You may attempt to sselect 
Application/Environment as a property only to find 
the product on which you are searching does not 
support that choice.

Selecting Product Options 

At some point in your selection process, your Tool Bar displays the Product Detail Button and Property 
Buttons.    At the same time the additional buttons display, a status line below your search path outline 
indicates:    Total Matching Products = X (where X is a numerical value).



The concept of the Property Buttons is very important.    It is one of the elements which makes this 
software unique in product selection.    The information necessary to describe a product is divided into 
four groups of data.    The four groupings are:

P/F    -    Physical/Functional:    What is the Product?

M/F    -    Material/Finish:    What is it made of?    How does it look?

I/M    -    Installation Maintenance:    How is it installed and maintained?

A/E    -    Application/Environment:    Where can it be used?    How can it be used?

The Product Detail Button brings up the Options dialog box containing an extensive list of additional 
qualifiers available for use in the specification.

The numeric qualifiers in the Options dialog box further narrows the scope of your search.    It is possible 
to use so many qualifiers that your choices become zero.    Watch the product counter at the bottom of the
box so you do not eliminate all products from your search.

The choices available in the Options dialog boxes are sometimes very broad in scope and sometimes 
very narrow.    The contents of the Options dialog boxes are dependent on the following:

· The specific point in the specification where you decide to use a Property Buttons and the 
Product Detail Button.

· The variety of options available as qualifiers.

It is important to remember as you are going through your selection process that you can alternate back 
and forth with the property buttons.    You may wish to have some of the characteristics specific to 
material/finish and others to physical/functional.    The software allows you to make these diverse choices 
to meet your needs.



Example Search

The following diagram illustrates a search for paint. Specifically, 

an exterior paint 

for wood 

that produces a smooth finish

in an alkyd base 

and produces a specular gloss.

Click the red text to learn more.    Click the Back command button to return to this screen.



Auto Picks



Selecting a Search Category
The Guide provides multiple Search Categories, start with the one that best suites your needs. Each one 
is linked to product areas in the Sweet's Product Area Index, the heart of the database. 

In the example, the CSI division (09900 - painting materials (general)) is linked to two Sweet's product 
areas: Paint and Other Coating.

All Products

Sweet's Data Filing Format (CSI)

Trade Name

Sweet's Product Area Index



Ellipsis (...)
An ellipsis (...) following a command tells you that additional picks are required to complete a selection. A 
selection is complete when it is opposite a product area.

Here are some examples:

Manufacturer Name

Key Word





The Sweet's Product Area Index
Each Search Category is linked to a product area in the Sweet's Product Area Index. In this case the CSI 
division (09900 - painting materials (general)) is linked to two Sweet's product areas: Paint and Other 
Coating.

The Sweet's Product Area Index is the heart of the database. Every search category is linked to the 
appropriate product area in the Sweet's Product Area Index.
Start with any search category. The software takes you to the appropriate product area in the Sweet's 
Product Area Index. Once in a product area, you are able to select product attributes. .

Had you started with the Sweet's Product Area Index, the search would appear like this.





Property Button Changes
The example search path uses three of the four Property Buttons. The Property buttons become active 
when the search leaves the original search category, in this case the Sweet's Data filing Format (CSI), 
and enters a product area in the Sweet's Product Area Index. 

1. The active Property Button is Physical Functional (PF), however, the example immediately 
switches to Application Environment (AE). The example selects an Exterior paint for a Wood 
surface.

2. The example switches back to Physical Functional (PF) and chooses a paint which produces a 
Smooth Surface.

3. The final Property Button change is to Material/Finish (MF). The example selects a paint in an 
Alkyd base that produces Specular Gloss.



End Selections on this Path
If one of the choices is ***End selections on this path***, there are multiple option paths available. The 
other paths are equal level paths with additional valid choices. Select ***End selections on this path*** 
to make selections on the other paths.

The following diagram illustrates the selection path from the previous screen in the form of a tree diagram.
The red line shows a selection sequence that finishes selecting on a path called Location and returns to 
an equal level path called Substrate.



AND vs. OR
Any two options can be characterized as AND selections, OR selections, or both. 

AND: If two choices are AND selections, they can both be selected as defining a product. For example: 
Paint can be both Exterior AND Interior grade. You may pick both Exterior and Interior at the same time.

OR: If two choices are OR selections, they are mutually exclusive. For example: Paint produces a 
Smooth Finish OR a Textured Finish. Once you select Smooth, you cannot select Textured.



Qualifier Options
Clicking the Product Detail Button brings up the Options dialog box. The Options dialog box contains a list
of qualifiers available for use in product selection. If Physical/Functional is the property in use, the items in
the dialog box reflect these properties.

If the Options dialog box contains many qualifiers, a scroll bar allows you to move to the other choices.

Based on the items you enter in the Options dialog box, it is possible to describe an item that does not 
exist in the database. If you do this, the Product Count at the bottom of the screen indicates a zero. Your 
Total Matching Products = line on the status bar also indicates zero.

Note:    Selecting some items will gray other items (make them non-selectable). 

The choices in an Options dialog box are referred to as qualifiers. At the bottom of several of the qualifier 
boxes is an area titled Logic Type. Two radio buttons are available: And and Or. The basic rules to 
remember when using these buttons are:

· The And Button is used to join together two or more requests (qualifiers). Using And says the 
product must meet all the qualifiers selected.

· The Or Button is used to join two or more requests for products meeting one criteria or another. 
Using Or says the product can meet one set of qualifiers or another set of qualifiers but does not 
have to meet all the qualifiers.

The Guide can provide measurement information to you in both Inch-Pound and Metric (SI). The 
software default is Inch-Pound. If you wish to switch to metric, click File from the main menu and click 
Configure from the pull-down menu. The Configure System dialog box displays. Make your choice in the 
Display Units.

Metric units used in SweetSource are based on SI Units* as defined by ASTM. 

*SI UNITS:    This standard is under the jurisdiction of ASTM (American Society for Testing and Materials) 
Committee EE-43 on Metric Practice and is the direct responsibility of Subcommittee E43.10 on 
Standards.



Auto Picks
The Guide often includes or adds selection criteria to the selection path automatically.    This saves time 
by bypassing selection criteria that are not applicable to the available products.    If the products available 
are confined to a specific group of features, the guide automatically displays the search path to the 
product group.



Viewing the Product Summary Screen
When you are satisfied with the scope of the product selected, click the Show Product Button and the Product 
Summary Screen displays.    The Data Windows show which manufacturers meet the criteria of your search.

Provide focus (click) to a specific Data Window and you can make your product choices from either 
Snapshots or Showcases.



All Products

This is a listing of all the products made by this manufacturer.    This search is quick and provides 
immediate access to specific products.    This is an advantage to users who are familiar with the 
manufacturer's product line.

Double Click the product name of your choice.    The Product Summary Screen displays.    Provide focus 
(click) to the Data Window which represents the specific product information you wish to see.    You can 
make your product choices from either Showcases or Snapshots.
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Sweet's Data Filing Format (CSI)

Sweet's Data Filing Format provides a filing system for the organization of building product literature and 
data.    It is based on the industry accepted 16 Division format and five digit coding system.    

The classifications listed are limited to those applicable to this manufacturer.

Click one of these divisions and you are taken through an increasingly definitive list of product 
characteristics.

As you make your choices, they appear in the outline area of the search path screen.    When you are 
satisfied with the scope of the product selected, click the Show Product Button.
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Trade Name

This is a listing of manufacturer supplied trade names and trademarks.    

Using this search path is fast and an advantage to the user who knows the exact product trade name he 
or she wishes to access.    You can bypass the normal product search paths and quickly go to your 
specific product choices.

Double Click the trade name of your choice.    The Product Summary Screen displays.    Provide focus 
(click) to the Data Window which represents the specific product information you wish to see.    You can 
make your product choices from either Showcases or Snapshots.

*Sweet's makes no representations or warrantees as to the rights of any manufacturer to any trade name 
or trademark listed in this software.
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Sweet's Product Area Index

Index headings are based on the manufacturer's descriptions of their products as those descriptions 
appear in the catalogs distributed by Sweet's.*    

After making product selections with this screen, use the    use the Show Product Button to access the 
Product Summary Screen where you can make your product choices.

*Sweet's makes no representations or warranties of any kind, express or implied, including but not limited 
to implied warranties of merchantability or fitness for any particular purpose as to these index headings or
as to the products described by these index headings.
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Glossary of Terms
Click
Double Click
Drag
Focus
Point
Select
Type



Click
Use your mouse to point to a choice in a dialog box, menu bar or list box, then press and 
release the left mouse button quickly.



Double Click
The purpose is similar to Click.    The action requires you to quickly press and release the left 
mouse button twice.



Drag
Point to an object or a location in text, then hold down the left mouse button while you move
the mouse.    Dragging moves objects or highlights text.



Focus
The highlighted area on the computer display where attention is currently directed; the data 
field where screen action is occurring.



Point
Slide the mouse on your desk to move the on-screen pointer to a new location.



Select
Use your mouse to point to the desired place or information and click the left mouse button.  
Or, hold down the left mouse button and drag the mouse to highlight the desired 
information.    Selecting does not start an action.    After selecting an item, you choose the 
action you want to affect the item.



Type
Use the keyboard to enter data into the active field, such as providing a name for a Project 
File.




